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The WLS-SPI

Introduction

The Smart Plug-in for BEA WebLogic Server (WLS-SPI) is a full-featured SPI
that allows you to manage WebLogic servers from an HP OpenView
Operations console. Read about WLS-SPI concepts in the online help. The
following topics are covered in the online help:

e Concepts

e Configuration editor
e Tools

e Policies

e Reports and graphs

e FError messages
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Installing, Upgrading, and Removing
WLS-SPI

This chapter covers installing, upgrading, and removing the Smart Plug-in for
BEA WebLogic Server (WLS-SPI)).

Installing WLS-SPI

If OVO is already installed, it is not necessary to stop your OVO sessions
before beginning the WLS-SPI installation. To install WLS-SPI, do the
following:

1 Insert the Smart Plug-ins and Integration Modules, New and Upgraded,
Volume 1 CD into the CD drive of the management server. The HP
OpenView Operations InstallShield Wizard starts.

2 From the first screen, select Next.
3 In the Program Maintenance window, select Install products.

4 In the Product Selection window, select the check box next to BEA
WebLogic and select Next.

5 Complete the installation by following the instructions in the windows
that display. Refer to the HP OpenView Operations / Performance for
Windows Installation Guide for more information.
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Upgrading WLS-SPI

Detailed information about supported software, enhancements, fixes, and
known problems and workarounds is available in the HP OpenView Smart
Plug-in for BEA WebLogic Server Release Notes, located on the Smart
Plug-ins, New and Upgraded CD, Volume 1, in

\Documentation\Releasenotes\WebLogic_AppServer_Releasenotes.html.

Policy Changes

All policies have been changed in this release of the WLS-SPI. If you have
customized any of the default WLS-SPI policies, you must make these same
customizations to the new version of each policy. During the upgrade process,
existing WLS-SPI policies in the SPT for WeblLogic Server policy group are
saved to another policy group. You can compare your old policies with the
newly installed policies and customize the new policies, as needed.

A new policy group hierarchy has been implemented as follows:

SPI for WebLogic Server
WLSSPI Discovery
WLSSPI

Logfiles
Metrics

Monitors

In this version, the WeblLogic Server groups have been replaced by a single
group named WL.SSPI. Also, the collector policies, WL.SSPI-ConfigCheck policy,
and WL.SSPI-Performance policy have been move into a new group named
Monitors.

12



Chapter 2

Before Starting

Before upgrading to WLS-SPI version B.03.61, you must first upgrade OVOW
to version 7.5. Then, install the new version of the WLS-SPI by running the
InstallShield Wizard (installer). If the installer detects that an older version
of the WLS-SPI is installed, it upgrades to the new version by doing the
following:

Renames the existing SPT for WebLogic Server policy group to SPT for
WebLogic Server - Saved Policies. If you customized any of the
default policies in the SPT for WebLogic Server policy group, the
customized policies are available in the SPT for WebLogic Server -
Saved Policies policy group.

Updates the WLS-SPI instrumentation on the management server.

Saves the existing WLS-SPI configuration file
\<80vInstallDir$>\SPI-Share\WLSSPI\English\conf\SiteConfig and
reinstalls it with the upgraded version of the WLS-SPI.

Deletes the existing \<%0vInstallDir$>\SPI-Share\WLSSPI and
\<%0vInstallDir%>\install\WASSPI\WLSSPI directories on the
management server.

Installs new tools, policies, and graph file on the management server.

Upgrading WLS-SPI

To upgrade to WLS-SPI version B.03.61, do the following:

1

Install the WLS-SPI version B.03.61 software:

a Insert the Smart Plug-ins and Integration Modules, New and
Upgraded, Volume 1 CD into the CD drive of the management server.
The InstallShield Wizard starts.

b From the first screen, select Next.
¢ In the Program Maintenance window, select Install products.

d In the Product Selection window, select the check box next to BEA
WebLogic and select Next.

e Complete the installation by following the instructions in the windows
that display. Refer to the HP OpenView Operations/ Performance for
Windows Installation Guide for more information.

13
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2

Refresh the SPI for Weblogic Server node group:

a

In the console tree, select Tools = SPI for WebLogic Server > WebLogic
Server Admin = Create WLSSPI Node Groups.

All the nodes found in the WLS-SPI service map are placed in the SPT
for WebLogic Server node group.

Uninstall all older versions of WLS-SPI policies from existing nodes
(versions 3.0 and lower). This includes any customized policies that you
may have moved outside of the old SPT for WebLogic Server policy
group and does not reside in the SPT for Weblogic Server - Saved
Policies policy group.

a

b

In the console tree, select Policy management - Policy groups.

Select the SPI for WebLogic Server - Saved Policies policy group and
right-click on it.

Select All tasks - Uninstall from.
Select the node group SPI for WebLogic Server.
Select OK.

Repeat these steps for any customized WLS-SPI policies that do not
reside in the SPT for WeblLogic Server - Saved Policies policy

group.

Deploy new instrumentation to the SPT for WebLogic Server node
group:

a
b
c
d

e

Select the SPI for WebLogic Server node group and right-click on it.
Select All Tasks = Deploy instrumentation.
Select SPI for WebLogic Server.

Verify that the Remove existing instrumentation before
deploying new instrumentation checkbox is NOT selected.

Select OK.

Customize the new policies in the WLSSPTI policy group to match old
customized policies. Compare old and new policies by opening them side
by side.
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Deploy the new policies.
To deploy all polices in the WLSSPI policy group to all WebLogic nodes:

a Drag and drop the WL.SSPI policy group on the SPI for WebLogic
Server node group.

To deploy the WL.SSPTI policy group to selected WebLogic nodes:

a Right-click on WLSSPI.
b Select All Tasks — Deploy on ...
¢ Select the node(s) on which to deploy the policy group.
d Click OK.
To deploy a single policy:
Right-click on the policy.

Select the node(s) on which to deploy the policy.
Click OK.
Remove old policy groups (optional):

a
b Select All Tasks = Deploy on ...
c
d

In the console tree, select Policy management - Policy groups.

Select the SPI for WebLogic Server - Saved Policies policy group and
right-click on it.
Select Delete.

Select Yes to delete the SPTI for WeblLogic Server - Saved
Policies policy group.

e Select and remove any WLS-SPI policies you may have moved outside
of the old SPI for WebLogic Server policy group and do not reside in
the SPI for WeblLogic Server - Saved Policies policy group.
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Removing WLS-SPI

The complete removal of the WLS-SPI deletes all WLS-SPI program
components as well as the WLS-SPI policies.

Complete the tasks in the order listed

Task 1
Nodes

Task 1: Uninstall All WLS-SPI Policies from the Managed Nodes
Task 2: Remove WLS-SPI Node Groups on the Management Server
Task 3: Remove Any SPI for WebLogic Server Groups

Task 4: Remove the WLS-SPI Software from the Management Server

: Uninstall All WLS-SPI Policies from the Managed

If you have customized policies (copies of WLS-SPI default policies) residing in
other OVO policy groups, you should remove them as well.

1
2

In the console tree, select Policy management - Policy groups.

Right-click on SPI for WebLogic Server and select All Tasks = Uninstall from.
A node selection window appears.

Select the nodes on which the policies are installed.
Select OK.

Verify the policies are uninstalled. Check the status of the job in
Deployment jobs under Policy groups. All WLS-SPI policies must be
uninstalled before you start the next task.

Task 2: Remove WLS-SPI Node Groups on the Management

Server

If you ran the Create WLSSPI Node Groups tool, the SPI for WebLogic Server
node group was created and must be removed:

1

In the console tree, select Nodes = SPI for WebLogic Server.
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Open the Node Configuration editor.

a Select the Nodes folder in the console tree.
b Click 2 on the Configuration toolbar to open the editor.

In the Nodes list, either select the name of the node group you want to
delete and press the Delete key or right-click on the node group and select
Delete.

Click Yes to continue the delete operation.

Task 3: Remove Any SPI for WebLogic Server Groups

1

Under Tools, Policy management - Policy groups, Reports & Graphs —
Reports, and Reports & Graphs - Graphs, look for the SPI for WebLogic
Server group.

If the SPI for WebLogic Server group exists, remove it and its contents.

If you upgraded the SPI, also remove the SPI for WebLogic Server - Saved
Policies group from Policy management —> Policy groups.

Task 4: Remove the WLS-SPI Software from the
Management Server

1

Insert the HP OpenView Smart Plug-ins CD into the CD drive of the
management server. The HP OpenView Operations InstallShield Wizard
starts.

From the first screen, select Next.
In the Program Maintenance window, select Remove products.

In the Product Selection window, select the check box next to BEA
WebLogic and select Next.

Complete the removal by following the instructions in the windows that
display.

17
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Configuring WLS-SPI

Introduction

This chapter covers configuring the Smart Plug-in for BEA WebLogic Server
(WLS-SPI) for use with OpenView Operations (OVO). To successfully
configure WLS-SPI, you must complete all configuration prerequisites,

complete basic configuration, and complete additional configuration based on
your environment.

Configuration Prerequisites

Complete the following tasks before configuring WLS-SPI:
e Task 1: Add OVO Managed Nodes
e Task 2: Verify the Application Server Status

e Task 3: Collect Application Server Information

19
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Task 1: Add OVO Managed Nodes

For each WebLogic Administration Server and WebLogic managed server you
want to manage from OVO, make sure each node on which the WebLogic
servers are running is configured in OVO as a managed node.

To add a UNIX managed node, do the following:

1

2

Install the OVO agent on the node. Refer to the OVO online help topic
“Agent Installation on UNIX computers” for more information.

Specify each WebLogic Server node on UNIX to be managed. Refer to the
OVO online help topic “Configure Managed Nodes” for more information.

To add a Windows managed node, do the following:

1

Specify each WebLogic Server node on Windows to be managed. Refer to
the OVO online help topic “Configure Managed Nodes” for more
information (the OVO agent is automatically installed when you complete
this step).

Task 2: Verify the Application Server Status

Verify that your application servers are running by checking a server’s status
from the WebLogic administration console. The WLS-SPI discovery policies

only find application servers that are running.

/3 WebLogic Server Console - Microsoft Internet Explorer [_ol=]
J Ele Edit ‘View Favorites TIools Help ‘
| wBack ~ = - (@D (3] A Dscarch [(Fovorites (AHistory | By S
| address [#] _14531019451 68MB2an=mydomain®34tame %3Dmydomain:2C Type % 3DDomatbodyFrameld=wl_conscle_frame_1046310194517 || P60 |JLinks @
@ Console _
2 @ rydormain mydomain> Servers
E ngers Otst: 7003 Active Domain: mydomain
myserver
&lcisters
machines B/Configure a new Server
Enetwork Channels
2 Hoepioyments Bl Customize this view. .
appiications
B N Listen Port| Listen Port Enable | Stat
E]WEIJ fnplications ame Isten Fo 1SteN Fo| naple ate
Elwen Senvice Components myserver | 7003 true RUNMIMG || 7 8
E]Cnnnectnrs
Startup & Shutdawn
B Bsenices
Eicom
Hpec
—_ A
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Task 3: Collect Application Server Information

Basic information about your environment is needed to configure WLS-SPI:
e  WebLogic login and password

e (OVO managed node name(s) on which the WebLogic Administration
Server(s) are running

WebLogic Login and Password

Collect the WebLogic login and password for each WebLogic Administration
Server. Or, if you do not wish to use the existing login and password, create
them. The login and password are needed by the WLS-SPI discovery process
to gather basic configuration information and by the WLS-SPI data collector
to collect metrics.

Configuration of the WLS-SPI is simplified if the WebLogic login and
password are the same to access all WebLogic Administration Servers.

WebLogic Server Version 5.1 and 6.x

If you are running WebLogic Server version 5.1 or 6.x, you can use the default
administration login “system.”

If you want to configure a different login, do the following:

1 In the WebLogic Server administration console, create the login and
password that you plan to use for the WLS-SPI), if it does not already
exist.

2 Create an ACL named weblogic.admin.mbean if it does not already exist.

3 Create a permission named access for this ACL if it does not already
exist.

4 Add the login (created in step 1) to the list of users for the access
permission (created in step 3).

WebLogic Server Version 7.0 and Higher

If you are running WebLogic Server version 7.x, you can use the
administration login that was configured when you installed the WebLogic
Server.

If you want to configure a different login, do the following:

1 In the WebLogic Server administration console, create a login.
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2  Assign that login to the Administrators group.

For more information about creating a login and assigning a login to a group,
refer to the “Users and Groups” section of the Securing WebLogic Resources
manual (http:/e-docs.bea.com/wls/docs70/secwlres/
usrs_grps.html#1150651).

OVO Managed Node Name(s)

Collect the names of the OVO managed node(s) on which the WebLogic
Administration Server(s) are running. You must select these managed node(s)
when you configure WLS-SPI.

You do not need to collect the names of the OVO managed node(s) on which
only a WebLogic managed server is installed. On these OVO managed nodes,
as long as the WebLogic managed server is running, the WebLogic managed
server is automatically discovered when you complete the basic WLS-SPI
configuration.

Basic WLS-SPI Configuration

To complete basic WLS-SPI configuration, complete the following tasks:
Task 1: Run Discover WebLogic

Task 2: Verify the Discovery Process
Task 3: Set Additional Properties

Task 1: Run Discover WebLogic

Discover WebLogic sets basic configuration properties needed for discovery
and deploys the WLS-SPI discovery policies.

To run Discover WebLogic, do the following:

1 From the OVO console, select Operations Manager - Tools — SPI for
WebLogic Server = SPI Admin.

2 Double-click on Discover WebLogic.

22
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Select the managed nodes on which the WebLogic Administration
Server(s) are running.

Click Launch.

The “Console Status” window displays. Wait a few seconds for the
“Introduction” window to display. This window contains brief information
about the Discover WebLogic tool.

Select Next.

A second “Introduction” window displays. This window displays
information on which properties may be required in order for the
discovery process to work.

Read this information and select Next.
If you have not set the WLS-SPI 1.0GIN and PASSWORD properties, the “Set

Access Info for Default Properties” window displays.

f2, WLSSPI Discover Tool: Set Access Info for Defaull - 10] x|

FPlease enterthe Lagin and Passwaord infarmatian.
This information is required by the SP1to access a secured

application semer's environment. Flease click Help for mare details.

Laogin l

FPassword I

Werify Password I

Custormize | et | Cancel Help

If you have already set the LOGIN and PASSWORD properties, the
configuration editor displays. Go to step 8.

Set the LOGIN and PASSWORD properties to the WebLogic login and
password collected in Task 3: Collect Application Server Information on
page 21. You must set the LOGIN and PASSWORD even if you are using the
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default login/password (WebLogic version 5.1 and 6.x) or the login/
password configured during the WebLogic Server installation (WebLogic
version 7.0 or higher).

The LOGIN and PASSWORD properties set in this window are used as the
default WebLogic login and password (they are set at the global properties
level). That is, if no NODE level or server-specific LOGIN and PASSWORD
properties are set, this WebLogic login and password are used by
WLS-SPI to access all WebLogic Administration Servers. For more
information about the configuration structure, refer to the online help
topic “The configuration.”

If the WebLogic Administration Server login and password are the same
for all instances of WebLogic on all OVO managed nodes, do the following:

a Set the LOGIN and PASSWORD in the “Set Access Info for Default
Properties” window.

b Select Next.
¢ Go to step 10.

If the WebLogic Administration Server login and password are different
for each managed node but are the same for all instances of the WebLogic
Administration Server on each managed node, you must customize the
WLS-SPI configuration by setting the LOGIN and PASSWORD properties at
the NODE level (for more information about the configuration structure,
refer to the online help topic “Configuration editor operation.”):

a Set LOGIN and PASSWORD to the most commonly used WebLogic login
and password in the “Set Access Info for Default Properties” window.

b Select Customize to start the configuration editor and set the LOGIN
and PASSWORD properties at the NODE level.

If the WebLogic Administration Server login and password are different
for each managed node and they are different for the instances of the
WebLogic Administration Server on a managed node, you must customize
the WLS-SPI configuration by setting the .OGIN, PASSWORD, NAME, and
PORT properties at the server-specific level (for more information about
the configuration structure, refer to the online help topic “The
configuration.”):

a Set LOGIN and PASSWORD to the most commonly used WebLogic login
and password in the “Set Access Info for Default Properties” window.
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b Select Customize to start the configuration editor and set the LOGIN,
PASSWORD, NAME, and PORT properties at the server-specific level.

From the configuration editor, set the properties. Refer to the online help
for more information about using the configuration editor.

Select Next to save any changes and exit the editor.

The “Confirm Operation” window displays. Select OK. The discovery
policies are deployed to the selected managed nodes.

) If you select Cancel, the discovery policies are not deployed. However, if you
made changes to the configuration, those changes remain in the
configuration on the management server. To make the changes to the
selected managed nodes’ configuration, you must start the Discover
WebLogic tool, select those managed nodes, select Next from the
configuration editor, and then select OK.

11

Scan the “Console Status” window for any error messages. If none display,
click on Close.

If the window displays an error message, refer to The WLSSPI Discovery
Policies on page 85 in the Troubleshooting WLS-SPI chapter to diagnose
the problem.

Task 2: Verify the Discovery Process

Depending on the number of managed nodes in your environment, verification
takes several minutes to complete.

1

Verify that the following message appears in the message browser of the
managed node:

Updating WLS-SPI configuration in OVO server for <node>

and verify that the following message appears in the message browser of
the management server:

The SPI configuration for <node> was updated by discovery in
the OVO server. The updated configuration is as shown below

Depending on the number of managed nodes in your environment, it may
take several minutes for these messages to display for all managed nodes.
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If these messages are present, the WLSSPI Discovery policies have been
successfully deployed.

If these messages are not present, go to Task 3: Set Additional Properties
on page 27.

View the service map and verify that the WebLogic and WebLogic Server
instances are correctly represented.

After the discovery process has completed, the appropriate WLSSPI group
policies are deployed on the managed node(s). An automatic procedure to
set up a managed node for WLSSPI operations starts about 10 minutes
after the policies are deployed. Wait 10 minutes and run the Verify tool to
verify the version of the policies installed on a managed node:

a From the OVO console, select Operations Manager - Tools - SPI for
WebLogic Server = SPI Admin.

b Double-click on Verify.

c Select the node(s) to verify (select all managed nodes running
WebLogic Administration Servers and WebLogic managed servers).

d Click Launch.

e The WLS-SPI version is displayed. The version should be B.02.05 or
higher.

f Click Close.

If verification is successful, go to Additional WLS-SPI Configuration on
page 29. Otherwise, go to Task 3: Set Additional Properties.
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Task 3: Set Additional Properties

LOGIN and PASSWORD are the basic properties needed by the discover process.
However, depending on your environment, additional configuration properties
may be needed by the discover process. Refer to the online help for a complete
definitions of the properties.

If multiple versions of the WebLogic Server are installed on a node,
set:

e JAVA HOME - The default directory where Java is installed. Use the highest
version of Java available. If you are running WebLogic Server version 8.1,
you must use Java version 1.4.1 or higher.

If you are using SSL on the application server port, set:

e PROTOCOL - Specifies if the application server port is using SSL or
non-SSL.

e KEYSTORE - The fully-qualified path to the SSL trust keystore file.

e PASSPHRASE - The passphrase defined when the keystore was created on
your WebLogic Server. If a keystore was not defined with a password, do
not set this property.

e ADMIN_PORTS - The SSL port on which the application server is listening.
If more than one version of Java is installed, set

e JAVA HOME - The default directory where Java is installed. Use the highest
version of Java available. If you are running WebLogic Server version 8.1,
you must use Java version 1.4.1 or higher.

If you did not use BEA’s installation scripts to install the WebLogic
Server and service packs, set:

e HOME_LIST - A list of directories where the WebLogic Server is installed.

e JAVA HOME - The default directory where Java is installed. If you are

running WebLogic Server version 8.1, you must use Java version 1.4.1 or
higher.

If WebLogic Server is configured to a virtual IP address, set:

e ADDRESS - The domain name or IP address where the WebLogic Server is
listening.
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If a remote WebLogic Server is listening on a virtual IP, set:

e NODE_NAMES - The virtual IP address where the server is listening. If not
set, the remote WebLogic Server is not discovered

If the WebLogic Server’s domain configuration file is not located in
the default directory, set:

e ADMIN_PORTS - The port number(s) of WebLogic Admin server(s). The
domain configuration file (config.xml) may be located in the default
directory:

— <WebLogic_Install_ Dir>/config/<WebLogic_Domain>/
(WebLogic 6.x)

— <BEA_Home_Dir>/user_projects/domains/
<WebLogic_Domain>/ (WebLogic 7 or 8)

where <wWebLogic_Install_Dir>is the directory where the WebLogic
Server is installed, <BEA_Home_Dir> is the directory that contains the

registry.xml file, and <WeblLogic_Domain> is the WebLogic domain
name.

If the BEA registry.xml file is not accurate or cannot be found, set:
® HOMFE_LIST - A list of directories where the WebLogic Server is installed.
To reduce the amount of time for the discover process to run, set:

e EXCLUDE_SAMPLES - By setting this property to “true,” the WebLogic
Server sample programs are not included in the discover process. It is
recommended that you set this to “true” at the default properties level to
reduce the amount of time it takes for the discover process to run. The
discover process can take several minutes to complete.

To set one or more of these properties, do the following:

1 Repeat Task 1: Run Discover WebLogic on page 22. When you get to step
8, set one or more of the properties listed above.

2 Repeat Task 2: Verify the Discovery Process on page 25.

3 Ifverification is successful, go to Additional WLS-SPI Configuration on
page 29.

If verification is not successful, view the error messages in the message
browser and follow the instruction text to correct the problem.
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Additional WLS-SPI Configuration

Once you have successfully completed basic WLS-SPI configuration, you must
finish WLS-SPI configuration by setting additional configuration properties
(these properties are not automatically discovered by the Discovery policies)
and/or installing and configuring additional components. Setting some of
these properties and configuring additional components depends on your
environment.

Refer to the online help for a complete definition of the properties.

To run the Start WebLogic and Stop WebLogic tools from the OVO
console, set the START CMD, STOP_CMD, and USER properties.

If you are configuring user-defined metrics, refer to the JMX Metric
Builder release notes for additional installation information and the JMX
Metric Builder online help for additional configuration information.

If HP OpenView Performance Manager is installed (must be purchased
separately and is not the version of OVPM that is included with OVO), refer to
Integrating WLS-SPI with HP OpenView Performance Manager on page 71
for additional installation and configuration information.

If HP OpenView Reporter is installed (must be purchased separately and
is not the version of Reporter that is included with OVO), refer to Integrating
WLS-SPI with Reporter to Generate Reports on page 66 for installation and
configuration information.

If absolute log file names are not configured in the WebLogic Server or
when the WebLogic Server’s installation and starting directories are
in different locations (WebLogic 6.x only), set the LAUNCH_DIR property.

To update the configuration, do the following:

1 From the OVO console, select Operations Manager - Tools — SPI for
WebLogic Server = SPI Admin.

2 Double-click on Configure WLSSPI.

3 Select the managed node(s) to configure.

4  Click Launch.

5 Click Next in the “Introduction” window.

6 Set the properties. Refer to the online help for more information about
using the configuration editor.
Select Save
Select Next.

9 Select OK.
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Introduction

Like all OpenView plug-ins, the Smart Plug-in for BEA WebLogic Server
(WLS-SPI) is easy to use. You should have installed the software, configured
the WLS-SPI connections, and deployed the policies. In the OVO message
browser, some messages may be appearing regarding the performance of
WebLogic Server.

As you become familiar with the WLS-SPI, you can determine which policies
are most useful to you and which you might want to change. This chapter
assists you by providing further detail on the policies and how to make those
changes.

In general the following topics are covered:

Using the WLS-SPI Policies

Basic Policy Customizations

Advanced Policy Customizations
Reinstalling WLS-SPI Policies

Using Policies/Tools to Generate Reports

Monitoring WebLogic on Unsupported Platforms
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Using WLS-SPI Policies

You can customize WLS-SPI policies (although they work without any
modifications). To help you understand how you might customize the
WLS-SPI policies, the following sections cover WLS-SPI policy groups and
general information about the OpenView Operations policies.

WLS-SPI Policy Groups

WLS-SPI policy groups provide a means of organizing various OVO policies.

Tree I Farvarites | SPI for WeblLogic Server
B 5 Palicy management ;I MName | Description
El- | Palicy groups = WLSSPI
+]- &8 Chster Management =B'\WLSSPI Discovery

B

-- =% Management server synchroniz.
2| Microsoft Windows

= Metwork Diagnosis Add-On Mod
=8| Movell Metware

2| O Operations Self Manager

=8| Samples

=4 Service Logging

=% SPI For Unix 05

28 9P For web Servers
[SRE=1ESFI For Weblogic Server
- =] WLSSPI

& WLSSPT Discovery _ILI
d - nillin | o

The WebLogic policy group contains the following metric and logfile policies:

e Metric (monitor) policies: generate messages according to threshold
settings that monitor WebLogic availability and performance metrics.

e Collector policies: pertain to all metrics scheduled to be collected in the
specified collection interval (grouped according to collection intervals).

e Logfile policies: generate messages according to logfile and error text
detected in both the WebLogic Server logfiles and in the WLS-SPI logfiles.

The WLSSPI Discovery policy automatically updates the WebLogic
configuration information in the service map. Uncheck the AUTO_DISCOVER
check box in the configuration editor if you do not want the discovery policy to
automatically overwrite this configuration information. Refer to the online
help for information on how to use the configuration editor.
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OVO Policy Types and WLS-SPI

Metric policies define how data is collected for the individual metric and set a
threshold value that, when exceeded, generate alerts/messages in the
Message Browser. You can change the threshold within a policy by
double-clicking on the policy, clicking on the Threshold levels tab, and clicking
on Threshold level in the Level summary pane.

Incoming values for metric WLSSPI-0012.1 are compared against its
threshold limits. In the figure below, the default threshold is set at 10.

Figure 1 Threshold Level Window
Threshold level "WLS5PI-0012.1: Minor threshold™ |

General | Start actionsl Continue actionsl End actionsl

Threshold level description” | SERSE

— F% Threshold limit [Masimum)]

Source »= [greater than or equal ko) I'I 1]

— Short-term peaks

[ lgnore single shart-term peaks occurring within IEI ::I b IEI ::I mISD ::I 5

= & Feset

* Reset value is same value as threshold limit

~ Specity a special reset value for the threzhald lewvel

Source ¢ [less than|® I

0K I Cancel | Help |

Collector policies define all metrics for the WebLogic Server application that
are scheduled for collection at the specified interval. Identified as a “metric
policy” in the OVO lists of policies, these policies have names different from
the individual metric policies. Within the name of each collector policy is its
collection interval (for example, WL.SSPI-70-1h, where the collection interval
is 1h or one hour). When you open any collector policy, you see all metrics (by
number) collected within the interval following the -m option of the collector/
analyzer command wasspi_wls_ca.
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Basic

>»

The figure below shows the Program name text box which contains the
collector/analyzer command (wasspi_wls_ca), followed by the collection
parameter and collection name (- ¢ WLSSPI-70-1h), followed by the metric
parameter and metric(s) collected (- m 240-242)

Figure 2 Program Name Text Box.

Froagram parameters
|V Program name® Iwasspi_wls_u:a -z WS SPI-F0-Th -m 240-242 _I

Policy Customizations

After you begin using the WLS-SPI, you may decide that specific WLS-SPI
policies need some modification. Descriptions contained in the previous
section of metric policies (rules for interpreting metric data, such as
thresholds) and collector policies (rules for the scheduled metric collection)
show you where to go to make the various changes. For example, to change a
threshold, open a metric policy. To schedule or delete a metric from data
collection, open the collector policy. These basic customizations are covered
in this section.

Make copies of the original policies so that the default policies remain intact.

Modifying Metric Policies

Many metric attributes can be modified for all monitored instances of
WebLogic Server. Attributes not mentioned here are defined in the online
help.

Threshold Level and Actions

To modify the threshold level and actions of a policy, do the following

1 From the OVO console, select Operations Manager - Policy management —
Policy groups —> SPI for WebLogic Server > WLSSPI = Metrics.
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Double-click on a policy.
Select the Threshold levels tab.

From the Level summary pane, click on Threshold level. The Threshold
level window displays.

Threshold level "WLSSPI-0026.1: Warning threshold™ 5'

General | Start actionsl Continue actionsl End actionsl

SPI-0026.1: “Warning threshold

Threghold level description®

— B2 Thiesheld limit [Masimurn

Source »= [greater than or equal o] I'I 0

— Short-term peaks
[™ Ignore single short-term peaks occuring within IEI ::I b IEI ::I il IBD ::I 5

= ﬁ Feset

{* Reset value iz same value as threshold limit

(" Specily a special reset value for the Hreshold level

Source ¢ [less than|? I

ak I Canhcel | Help |

In the figure above, the threshold limit is set to 10 for WLSSPI-0026. The
incoming values for this metric show the total number of times per minute
clients must wait for an available (Enterprise Java) bean. A value of more
than 10 would start to impact the server response time the client
experiences, generating a warning message.

The following attributes can be modified:

Threshold limit. The value that triggers a message if it is met or
crossed.

Short-term peaks. A minimum time period over which the monitored
value must exceed the threshold before generating a message. For a
message to be sent, the value must be greater than the threshold each
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time the value is measured during a duration that you select. If the
duration is set to 0 or the box is left empty, an alarm is generated as soon
as OVO detects that the threshold has been equaled or crossed.

¢ Reset. A limit below which the monitored value must drop (or exceed, for

minimum thresholds) to return the status of the monitored object to
normal.

Click on one of the actions tabs to set the following:

e Start actions. Actions carried out the first time that the threshold is
crossed.

Threshold level "WLSSPI-0026.1: Warning threshold™ il
General  Start actians | Continue actionsl End actionsl

If the threshold limit iz met or crossed, then start the specified actions [message
and commandz] and ztop checking other threghold levels.

— £, Start actions

" Acknowledged Msg, Browser or

% Active Mg Browser and
Start

Autornatic commarnd... |

wazzpl_wle_ca -r-mWLSSPI_002E6 -i <30FTIOMN[ze

Operator-initiated command. .. |

MHone

Qg Cancel Help
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Continue actions. Actions carried out at each subsequent polling

interval if the reset value is not reached.

Threshold level "WLSSPI-0026.1: Warning threshold™

Genelall Start actions  Continue actions | End actionsl

If the threshold limit is still met or croszed, then start the specified actions
[meszage and commandsz] and stop checking ather threshald levels.

% Don't start any continue actions
" Use the specified 'Start actions'

(" Define special 'Continue actions'

~i) Continue actions
Send flessage... | tar
! Acknowledoed Meg, Browser or

% Active bsa, Browser and
Start

Sutoratic commarnd.. |

MHone

[Iperator-nitiated commard!, . |

MHone

x|

akK I Cancel

Help
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End actions. Actions carried out after the threshold crosses the reset
value.

Threshold level “WLSSPI-0026.1: Warning threshold™ x|
Genelall Start actionsl Continue actions  End actions |

Start these actions if the last action for this threshald level was 'start’ or
‘continue’, ahd no threzhald level iz met or crozzed.

[~ Start the specified 'End actions'
—(ﬁ End actions

Send fezzage,.. | to

& Acknowledoed Meg, Brovser or

= Active Meg Browser and
Skart

Automatic command.. |

MHone

[ perator-mitiated command... |

Mane

oK I Cancel | Help |

In each of the actions tabs, you can set the type of actions to perform. The
WLS-SPI provides the ability to generate Performance Manager graphs or
reports, or to add custom programs. The reports or graphs are accessible to
the user from:

Automatic command. A command run when the rule is matched. The
automatic command delivered with the WLS-SPI generates a snapshot
annotations report that shows the data values at the time the action was
triggered from an exceeded threshold. You can view the report in the
message annotations.

Operator-initiated command. A command attached to the message
that the rule sends to the message browser. This command can be started
by the operator from the message browser. The operator-initiated
command delivered with the WLS-SPI allows the operator to press the
Perform Action button to view a graph of the metric whose exceeded
threshold generated the message along with other related metric values.
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Message and Severity

To modify the message and severity of a policy, do the following
1 Double-click on a policy.
2 Select the Threshold levels tab.

3 From the Level summary pane, click on Message. The Outgoing Message
window displays.

Outgoing Message il
Message attributes | Message c:onelationl Instructionsl Message stream interface and exte_4 I ’I

Service D JB_<$OPTION zervernamel> <$0PTIOM[zerverport]: J
hosted on I j
Message Key I j
Meszage Type | j
Meszage Group I j
Application I j
Object | j

Nads [ =l 4
Severity A Warning j
Message Text LS SPI-0026.1: # of times per minute a client timed out waiti
4| | i

] I Cancel | Help |

The following attributes can be modified:

e Severity. Indicates to the operator the importance of the event which
triggers this message.

e Message Text. Be careful not to modify any of the parameters—
beginning with $ and surrounded by <> brackets—in a message.
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Advanced Policy Customizations

The policy changes suggested here range from making copies of default policy
groups in order to customize a few settings, to deleting whole groups of
metrics within a policy’s command line. This section is considered advanced
because all changes described here, whether simple or complex, require some
advanced knowledge of the WLS-SPI metrics.

Choosing Metrics To Monitor

1

Determine the metrics you want to change and what policies within the
group you want to use.

Create a new policy group:

a Right-click on the policy group you want to copy and select Copy.
For example, right-click on the Metrics policy group under WLSSPI
and select Copy.

b Right-click on the group under which this policy group is located and
select Paste.
For example, right-click on WLSSPI and select Paste.

¢ Rename the new group.
For example, right-click on copy of Metrics and select Rename. Type
in a new name.

Rename the original policies within the new policy group:

a Right-click on the policy and select All Tasks — Edit.

b Click on File > Save As.

¢ Enter a new policy name and select OK.

Delete all original policies within the new policy group:

a Highlight the policies and hit Delete.

Alter the renamed policies within the new group as necessary.
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Creating a new policy group allows you to keep custom policies separate from
the original default policies.

Tree | Favorites | My Metrics
I3 3PI For Yeblogic Server | I\:Iame | Description
S &) WLSSPI ﬁMyMetric_ﬂDlS Server Restarts
. -3 Logfiles ﬁMyMetric_ﬂDSS Irevalid Login Attermpts Cou
ﬁMyMetric-?D-DSmin Runs the WebLogic Server

- &) My Mekrics

[~ &) Monitors J
&8 WLSSPI Discovery

1 I_PILI*I | i

Using the WLS-SPI Collector/Analyzer Command with
Parameters

The wasspi_wls_perl -S wasspi_wls_ca command is used in every
collector policy, named according to its collection interval. You can view the
default command line parameters within each collector policy in the

Program name text box in OVO.

Program parameters

Program name* wasspi_wls_perl -5 wasspi_wls_ca -c |
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Using the Basic WebLogic Server Command Parameters

WLS-SPI data collections are started with the wasspi_wls_ca command, to
which you can add other parameters, as identified in the following table.

Parameter

Description

-C

Required

(collector) Specifies the collector policy name. This must match
the collector policy name in which it appears.

Syntax: -c¢ <collector_policy. name>
Example: -c¢ WLSSPI-61-05min

(exclude) Allows you to exclude specific servers; may not be
used with -1 option.

Syntax: -e <server_name>

Example: -e server2, server4

(include) Allows you to list specific servers to monitor. This
option may not be used with -e option.

Syntax: -i <server_name>

Example: -i serverl, server3

(metric) Specifies the metric numbers or number ranges on
which to collect data.

Syntax: -m <metric_number, metric_number_range>
Example: -m 1,3-5,9-11,15

-matchver

(match version) Specifies the exact WebLogic Server version to
monitor. This option may not be used with the -minver nor
-maxver options. If no matching versions are found, the
command does not execute.

Syntax: -matchver <version number>

Example: -matchver 6.1

—maxver

(maximum version) Specifies the highest WebLogic Server
version to monitor. Use with -minver to specify a range of
versions. If no versions are found, the command does not
execute.

Syntax: -maxver <version number>

Example: -matchver 7
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Parameter | Description

-minver (minimum version) Specifies the lowest WebLogic Server
version to monitor. Use with -maxver to specify a range of
versions. If no matching versions are found, the command
does not execute.
Syntax: -minver <version_number>
Example: -matchver 6.1

-r (report) Generate an ASCII report for the specified metric(s).
Syntax: -r

-t (tag) Allows you to create a new policy group by adding a
prefix to an existing collector policy along with the metric
number(s).
Syntax: wasspi_wls_ca <prefix>-<collector _policy>
-m <metric_number> -t <prefix>-
Example: wasspi_wls_ca -c¢ WLSSPI-61-05min -m 220-223
-t DEV-

-x Allows you to specify a property and value.

Syntax: -X <property>=<property._value>

alarm When off, overrides any alarming condition as set
up in the metric policy.
Example: -x alarm=off

prefix | Default: JMXUDM_. Specify the prefix of the
metric ID.

Example: -x prefix=SALES_

print When on, prints the metric name, instance name,
and metric value to STDOUT in addition to any
configured alarming or logging.

Example: -x print=on

log When of f, prevents graphing or reporting
functions.

Example: -x log=off
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Examples
e To collect specific data on all configured servers:

wasspi_wls_ca -c WLSSPI-61-05min -m 10-14,25,26

e To collect data from specific servers only:

wasspi_wls_ca -c¢ STAGE-WLSSPI-61-05min -m 245,246,260
-i serverl, server3
e To not collect data from specific servers:

wasspi_wls_ca -c¢ STAGE-WLSSPI-61-15min -m 220-225
-e serverl, server?2

Using JMX Actions Command Parameters

The command parameters described in this section are used to run JMX
actions. JMX actions are one or more JMX calls (invoke, get, set) performed on
an MBean instance or type. A single JMX call can be performed from the
command line. Multiple JMX calls can be specified in an XML file or as a
Metric subelement in a UDM file.

Parameter

Description

—-a

Required

(action) Indicates a JMX action is performed.
Syntax: -a

-1

(include) Specifies server(s) on which to perform the JMX actions. If this
parameter is not specified, the JMX actions are performed on all configured
servers.

Syntax: -i <server._name>

Example: -i serverl, server3

-m

(metric) Specifies the metric ID containing the action to perform. This metric ID
must be defined in a UDM file. This option may not be used with the -mbean
nor -xml options.

Syntax: -m <metric_id>

Example: -m TestUDM_1000
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Parameter | Description
-mbean Performs a JMX call on the specified MBean(s). This option may not be used
with the -m nor -xml options.
Syntax: -mbean <objectname> <action>
Example:
-mbean *:*,Type=JMSServerConfig -get MessagesMaximum
where <action>(a JMX call) is one of the following:
-get Returns the value of the apecified attribute.
Syntax: -mbean <objectname> -get <attribute>
Example: -get MessagesMaximum
-invoke [-type]|Executes an MBean operation with the specified
parameters. An operation may not require parameters
(therefore, -type is not specified). A type parameter must be
specified for operations which accept parameters. -type
supports operation overloading.
Syntax: -mbean <objectname> -invoke <operation>
[-type <parameter type> <parameter. value>]...
where <parameter_type>is one of the following: short, int,
long, double, float, boolean, java.lang.Short,
java.lang.Integer, java.lang.Long, java.lang.Double,
java.lang.Float, java.lang.Boolean, and java.lang.String.
Example: -invoke stagingEnabled
-type java.lang.String examplesServer
-set Assigns the specified value to the specified attribute.
Syntax: -mbean <objectname> -set <attribute>
<value>
Example: -set MessagesMaximum 250000
-0 (object) Specifies an MBean instance.
Syntax: -o <mbean_instance>
Example: -0 examplesdMSServer
-xml Specifies the XML file that contains the JMX action(s) to perform. This option

may not be used with the -m nor -mbean options.
Syntax: -xml <filename>
Example: -xml myJMXActions.xml
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Examples

e Set the maximum threads for an alarming WebLogic execute queue to 50
(where <$OPTION (instancename) > specifies an alarming instance):

wasspi_wls_perl -S wasspi_wls_ca -a
-mbean “PetStore:*, Type=ExecuteQueueConfig”
-set ThreadsMaximum 50 -o <$OPTION (instancename) >

e Set the MessagesMaximum attribute to 25000 on multiple MBean
instances:

wasspi_wls_perl -S wasspi_wls_ca -a
-mbean *:*, Type=JMSServerConfig -set MessagesMaximum 250000
-i examplesServer

e Set the MessagesMaximum attribute to 25000 on a specific MBean
instance:

wasspi_wls_perl -S wasspi_wls_ca -a
-mbean *:*,Type=JMSServerConfig -set MessagesMaximum 250000
-i examplesServer -o examplesJMSServer

e Invoke an operation on multiple MBean instances:

wasspi_wls_perl -S wasspi_wls_ca -a
-mbean *:*,Type=ApplicationConfig -invoke staged
-i examplesServer

e Get the MessagesMaximum attribute (after a set command, used to verify
that the attribute was set):

wasspi_wls_perl -S wasspi_wls_ca -a
-mbean *:*, Type=JMSServerConfig -get MessagesMaximum
-i examplesServer

e Use the sample UDM TestUDM_1000 in the
wls_UDMMetrics-sample.xml file:

wasspi_wls_perl -S wasspi_wls-ca -a -m TestUDM 1000
-i examplesServer

e Use the sample actions xml file:

wasspi_wls_perl -S wasspi_wls-ca -a
-xml /var/opt/OV/wasspi/wls/conf/wls_JMXActions-sample.xml
-i examplesServer
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Changing the Collection Interval for All Scheduled Metrics

To change the metric collection interval, simply change the Polling Interval in
the appropriate collector policy. For example, to change the collection of
default metrics from 5 minutes to 10 minutes for the WLSSPI policy group
WLSSPI-70-05min collector policy, follow these steps:

1

From the OVO console, select Operations Manager — Policy management —
Policy groups —> SPI for WebLogic Server > WLSSPI.

Select Monitors.

Right-click on the collector policy WLSSPI-70-05min and select All Tasks —
Edit.

Click on File > Save As and change the Name to WLSSPI-70-10min.
Change the Polling Interval from 5m to 10m.

Modify the command line -c parameter to reflect the new policy name
(WLSSPI-70-10min) as follows:
wasspi_wls _ca -c¢ WLSSPI-70-10min....

Deploy the new policy:
a Right-click on WLSSPI-70-10min.
b Select All Tasks = Deploy on ...

(2]

Select the node(s) on which to deploy the policy.
Click OK.

o
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Changing the Collection Interval for Selected Metrics

To change the collection interval for selected metrics, copy the appropriate
collector policy, rename it with a name reflecting the new interval, delete all
but the metrics you are changing, set the new interval, and edit the original
policy to remove the changed metrics. For example, to change the collection
interval to 10 minutes for metrics 70-81, follow these steps:

10
11
12

Pragram parameters
’7 Praogram name* IWLSSF‘I-?U-DSmin -m 1,261 33 A 5909 _I

From the OVO console, select Operations Manager - Policy management —
Policy groups — SPI for WebLogic Server > WLSSPI.

Select Monitors.

Right-click on the collector policy WLSSPI-70-05min and select All Tasks —
Edit.

Click on File » Save As and change the Name to WLSSPI-70-10min.

In the Program name text box, delete all metrics after the -m except
70-81.

Change the Polling Interval from 5m to 10m.

Modify the command line -c parameter to reflect the new policy name
(WLSSPI-70-10min) as follows:
wasspi_wls_ca -c WLSSPI-70-10min....

Select Save and Close.

Right-click on the collector policy WLSSPI-70-05min and select All Tasks —
Edit.

In the Program name text box, delete metrics 70-81 after the -m.
Select Save and Close.

Deploy the new policies:

a Right-click on WLSSPI-70-10min.

b Select All Tasks = Deploy on ...

¢ Select the node(s) on which to deploy the policy.

Click OK.

e Right-click on WLSSPI-70-05min and repeat steps b-d.

o
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Customize the Threshold for Different Servers

Customize the threshold as needed. For example, you may want to set the
threshold to 20 for SERVER_1 for metric 0012 and leave the threshold at 10 for
all other servers. To do so, copy the existing condition and modify it to serve as
the exception. Follow these steps:

1

a H W N

»

10
11
12
13
14
15
16

17

Double-click on the metric to open it for customization (for example,
double-click on WLSSPI_0012).

The Measurement Threshold window displays.

Select the Threshold levels tab.

Press the Specify instance filters button.

Select the Condition tab.

Enter a Rule description (for example, "Rule for all servers except
SERVER_1").

Press OK.

In the Measurement Threshold window, press the Copy button to make a
copy of the rule.

Double-click on the copy of the rule. Enter a new Rule description (for
example, "Rule for SERVER_1").

In the Object name matches field, enter the desired characters to use for
pattern matching (in this example SERVER_1).

Select the Actions tab.

Double-click on the condition.

Change the name of the condition to WLSSPI-0012.2.
Change the Threshold limit to 20.

Press OK.

Press OK.

Verify the order of your rules (for example, make "Rule for SERVER_1"
the first rule).

Click the Matching test button to test the pattern and verify pattern
matching (you must set up a match file first).
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Creating Custom, Tagged Policies

Another advanced customization option is to use the tag option (-t on the
command line) , which allows the collector/analyzer to recognize customized
policies that have a tag attached to the name. This option provides you with
the flexibility of using more than a single set of policies to define conditions
pertaining to specific installations of WebLogic Server.

When multiple nodes are managed by a number of groups, this option allows
you to create specially tagged policies that are separate from your original
setup. In such a case, you would make copies of the policies, rename them
with the tag and re-work the collector policy to pick up the tagged names,
then assign them to the various groups.

For example, you might create a group of policies and change each policy
name to include CLIENTO1 in it. A metric policy might be named
CLIENT01-WLSSPI_0012 (retaining the metric number, which must be used).
The collector policy name would be named FIRST CLIENT-61-05min. You
could then set up another group for SECOND_CLIENT and change all those
policies to include the CLIENT02 in the name.

To create the new policy group:
1 Copy the original policy group:
a Right-click on the policy group you want to copy and select Copy.
For example, right-click on the Metrics policy group under WLSSPI
and select Copy.
b Right-click on the group under which this policy group is located and
select Paste.
For example, right-click on WLSSPI and select Paste.
¢ Right-click on Copy of Metrics and select Rename. Rename the new
group according to how you plan to identify the new metric policies.
For example, rename the group to CLIENTO01Metrics.
2 Rename the original policies within the new policy group.
The names you give the new metric policies in the group would contain the

new name followed by the original metric number. For example, a copy of
WLSSPI_0001 could be called CLIENT01-WLSSPI_0001.
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The name you give the new collector policy would also contain the
identifying name. You would also modify the scheduled collection for the
new group by inserting the -t property in the Program name text box.
For example:

wasspi_wls_ca -c¢ FIRST CLIENT-61-10min -m 1,12,16
-t CLIENTO1l-

In this case the copied collector policy has been renamed:
FIRST CLIENT-61-10min

a Right-click on the policy and select All Tasks — Edit.
b Click on File > Save As.

¢ Enter a new policy name and select OK.

3 Delete all original policies within the new policy group:

Highlight the original policies and hit Delete.

Re-installing the WLS-SPI Policies

To restore the default WLS-SPI policy groups on your OVO management
server, you must remove and then reinstall the WLS-SPI. Refer to Removing
WLS-SPI on page 16 and Installing WLS-SPI on page 11 for more
information.

Using Policies/Tools to View Annotation
Reports and Graphs

Some policies have actions defined with threshold violations or error
conditions that automatically cause reports to appear in the message
Annotations. These reports are snapshots of data values collected from the
server around the time that the alarm occurred.
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Other policies have operator actions associated with them that allow you to
generate a graph.

The reports discussed in this section should not be confused with those
generated by OpenView Reporter, which show more consolidated, historical
data generated as Web pages in management-ready presentation format.

You can access the data as follows:

To view the Message Properties. Double-click on a message in the
OVO message browser. Reports can be viewed from the Annotations tab
area, showing data values on a single server.

To view reports. From the OVO console, select Operations Manager -
Tools > SPI for WebLogic Server - Metric Reports. Double-click on the
report. A report is generated for all WebLogic Server instances on the
selected managed node.

To view graphs. Double-click on a message in the OVO message
browser. Graphs can be generated in the Commands tab area, if an
operator-initiated command has been configured and data has been
collected. Select Start to generate the graph.

The View Graphs application launches your Web browser, which displays
the graphing feature available in HP OpenView Performance Manager
(which must be purchased separately).
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Automatic Command Reports

Many metrics generate Automatic Command Reports. These reports are
generated as soon as an alarm is triggered in OVO.

How you know a report has been generated

When an Automatic Command Report is executed from OVO, the server is
queried for additional data. If your message browser is set to display the
SUIAON column, you will see an “S” under the “A” column (see illustration),
which indicates that a generated report is available in the Annotations area of
the Message Properties.

Modes  Wiew: Message Browser - Active Messages

Severik | 5 | U | I | & | o] | I | Received % | Group | Applicatio | Objeil
) Wrarning - - X - - - 1J14/2003 10:06:34 AM OpC HP Opendiew Operations  opcn

& wlatning - - - - - - 1J15/2003 12:57:15 PM WINOSSPI-MNG, .. MNorton Ankivirus ot
@ Marmal 11172003 9:34:23 AM VP_SM HP Opertiew Operations  OwD

2003 127 Weblogic ‘WebLogic

& Warning - - o~ - - - 1f17/2003 9:39:24 AM OpC HP Openliew Operations  opcn
@Critical - - = = - = 1232003 %:05:22 AM YP_5M HF Openview Cperations F\Eij
4| | 3

sz o |0 [ 7 |@s [elo |0 |40 50000

How to view the report

To view the report, double-click on the message and select the Annotations
tab. Column descriptions provide further clarification.

How Automatically Generated and Manually Generated Reports Differ

Automatic Command reports show the state of the system moments after the
alarm occurred. You can manually generate a report that shows the current
state of the system by navigating down the console tree to the individual SPI
for WebLogic reports and double-clicking on the report.

Reports

Reports run for all WebLogic Server instances configured on the managed
node, in contrast to Automatic Command Reports which are generated for a
single WebLogic Server instance. The reports generated reflect the current
state of WebLogic Server on the managed node.
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To generate a report in OVO, simply navigate down the console tree to the
individual SPI for WebLogic reports, double-click on the report, and select a
managed node.

Use these tools to manually generate a report similar to an Automatic
Command report. These reports differ by showing data on ALL WebLogic
Server instances on the managed node. The Automatic Command report

shows data on the single WebLogic Server instance with the exceeded
threshold

Sample Report

The following example shows the format of a WLS-SPI report. This report is
automatically generated (automatic command report).
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Figure 3 Report on Metric B-011
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Monitoring WebLogic on Unsupported Platforms

The WLS-SPI supports monitoring WebLogic Server-installed systems
running on HP-UX, Solaris, Linux, Windows 2000, and AIX. However, it is
possible to configure the WLS-SPI to monitor a WebLogic Server installed on
systems running on unsupported platforms—systems we refer to as “remote
systems.”

The intent of this section is to help you determine if your environment is
conducive to setting up remote monitoring. If you determine that your
environment meets the criteria described below, and you have some expertise
in using the WLS-SPI, this section offers an example to get you started.

Requirements for Monitoring Remote Nodes (running on
Platforms not supported by WLS-SPI)

For a WebLogic Server installation on a system running on a platform other
than HP-UX, Solaris, Linux, Windows 2000, or AIX, you can use WLS-SPI to
monitor that remote system if the following conditions apply. The last
condition is optional:

e The remote system is covered by a purchased license (using Tier 1
pricing).

e The WLS-SPI runs on at least one managed node on a supported platform:
HP-UX, Solaris, Linux, Windows 2000, or AIX.

e (Optional, for logfile monitoring) The remote system runs on a platform
supported by the OVO agent software.

Overview

The following section provides an overview of remote monitoring and shows
how it is implemented. Also included are details on how to set up the
WLS-SPI to access WebLogic Server metrics and logfiles on unsupported
platforms by using both the WLS-SPI and OVO agent software.

Remote Monitoring: How It Works

In a standard configuration, WLS-SPI programs/policies are deployed on the
local, managed node. In a non-standard configuration, the local system is used
as a proxy through which remote metric information becomes accessible.
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Remote system data collection/interpretation relies on the local, managed
node to act as the proxy on which data collection is configured.

OpenView Operations OpenView Operations
Managed Node Management Server
Proxy System L5 !
| WLs-SPI
! Policies

Configuration entries requirement: Within the configuration, entries for both
local and remote systems are included. You can include multiple remote
system entries in a local system’s section. (Please refer to the example on
page 59, showing how the remote entry appears (with system IP address).

Policy deployment requirement: Policies must be deployed on the local node.
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OVO agent deployment requirement (optional logfile monitoring): To access
remote WebLogic logfiles, the OVO agent software must be installed on the
remote system. Using standard OVO processes, you can modify the standard
logfile policies included with the WLS-SPI to specify the correct logfile names,
then deploy them to the remote system.

) Monitoring remote systems using logfile versioning is not supported.

Configure Remote System Monitoring

You can monitor WebLogic servers remotely on systems other than those
running on HP-UX, Solaris, Linux, Windows 2000, or AIX platforms by
completing the following tasks.

Task 1: Configure the Remote WebLogic server

Using the Configure WLSSPI tool in the SPI Admin tools group, configure
each local managed node that communicates with a remote WebLogic server.
In the configuration, add entries for remote WebLogic servers.

1 Start the Configure WLSSPI tool.

2 Choose a WebLogic managed node from which to monitor the remote
WebLogic Server.

3 In the configuration, include an entry for each remote WebLogic server:
ADDRESS=<DNS server name or IP address>.

The example configuration below shows how local and remote WebLogic
servers are configured in the same file. Notice, however, that for the
remote servers the ADDRESS=<TIP address> line is added:

ADDRESS=15.75.27.109 or
ADDRESS=harley.hp.com
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Example Configuration

#

HHAHHAH A H AR AR AR AR AR AR SRR RS R R R R S
HOME=/opt/bea/wlsserver6.0spi

JAVA_HOME=/opt/bea/jdk130

SERVER1_NAME=classact
SERVER1_PORT=7001
SERVER1_LOGIN=serverl_admin
SERVER1_PASSWORD=serverl_password

SERVER2_NAME=harley
SERVER2_PORT=7002
SERVER2_LOGIN=server2_admin
SERVER2_PASSWORD=server2_password
SERVER2_ADDRESS=harley.hp.com

There are two WebLogic servers configured in the example configuration.
SERVERI is the local server, running on an HP-UX managed node. SERVER? is
running on an OVO-managed node, that is a system on a platform
unsupported by WLS-SPI. The remote system is configured similar to that of
the local system but contains the line SERVER2_ADDRESS=harley.hp.com.

Task 2: (optional) Integrate OpenView Performance Agent
(MeasureWare Agent)

Since the OpenView Performance Agent collection occurs on the managed
node, not the remote system, and if you use OpenView Performance Manager

and would like to graph the remote system data, you must ensure that
MeasureWare integration is enabled on the (local) managed node.

Task 3: Assign Local Node to WLS-SPI node group

Assign the local managed node to the SPI for WebLogic Server node group.
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Configuring Remote Monitoring for Logfiles (Optional)

Monitoring remote system logfiles is supported if the following is true: (1) The
remote system has an OVO agent running on it and (2) the system does not
re-version logfiles when they roll. To set up logfile monitoring, at the OVO
console, copy the WLS-SPI logfile policy and then configure, assign, and
deploy the copied logfile policy to the remote system.

Configure the logfile policy for remote logfiles

1

Open a copy of the WebLogic Log Policy located under the WebLogic
version Group.

a From the OVO console, select Operations Manager — Policy management
- Policy groups = SPI for WebLogic Server = WLSSPI.

b Select Logfiles.
¢ Double-click on the log policy

In the Logfile pathname text box, enter the location of the logfile on the
remote system: /<path>/<filename>.

Assign and deploy the logfile policy to the remote OVO-managed node.
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The Log File Policy and the OVO Agent, both present on the remote system,
make WebLogic Server logfile monitoring possible.

OpenView Operations OpenView Operations
Managed Node Management Server

Proxy System

Remote Monitoring Limitations

e The WLS-SPI and the OVO agent do not support access to logfiles that are
re-versioned each time the logs are rolled.

e  When an OVO agent is not present on the remote system, WebLogic
logfiles on the remote system cannot be monitored.

e  WLS-SPI tools cannot be executed on remote systems.

e  WLS-SPI does not support application servers with the same name.
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Using HP OpenView Reporting and
Graphing Features with WLS-SPI

TheSmart Plug-in for BEA WebLogic Server (WLS-SPI) can be integrated
with the following HP OpenView reporting and graphing products (these
products must be purchased separately):

e HP OpenView Reporter (Reporter)
e HP OpenView Performance Insight (OVPI)
e HP OpenView Performance Manager (OVPM)

HP OpenView Reporter. Reporter produces management-ready, web page
reports, showing historical and trending information. This is not the version of
Reporter that is included with HP OpenView Operations for Windows.

Working in conjunction with Reporter, the WLS-SPI produces a variety of
reports showing consolidated information on the WebLogic Application
Server.

Refer to Integrating WLS-SPI with Reporter to Generate Reports on page 66
for more information on how to integrate WLS-SPI with Reporter. After
integrating WLS-SPI with Reporter, every night, Reporter generates reports
that show the performance and availability of a WebLogic Application Server
on configured managed nodes.

HP OpenView Performance Insight. OVPI is a network management
system that collects, processes, and reports data. The data is used to generate
reports. Refer to the HP OpenView Performance Insight Administration Guide
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for more information about OVPI. Refer to the Application Server Report Pack
User Guide for more information about WLS-SPI reports and how to integrate
WLS-SPI with OVPI.

HP OpenView Performance Manager. OVPM provides graphing
capability. This is not the version of OVPM that is included with HP
OpenView Operations for Windows.

Refer to Integrating WLS-SPI with HP OpenView Performance Manager on
page 71 for more information on how to integrate WLS-SPI with OVPM. After
integrating WLS-SPI with OVPM, graphs are available the following day.
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Using the OpenView Performance Agent

WLS-SPI relies on the default performance subagent (CODA) to collect and
store performance data. CODA is automatically deployed on all OVO
managed nodes. The performance data collected by CODA is used by
integrated OVO for Windows graphing and reporting features (WLS-SPI
Metric Reports tools, automatic command reports, and operator-generated
graphs), Reporter, OVPI, and OVPM. The integrated OVO for Windows
reporting and graphing features only work with data collected by CODA.

However, you may want to use the OpenView Performance Agent 3.x (OVPA
or MeasureWare Agent) to collect and store performance data (OVPA is a
product that must be purchased separately). The data collected by OVPA is
used by Reporter, OVPI, and OVPM. The integrated OVO for Windows
reporting and graphing features cannot use data collected by OVPA and
therefore these features do not work if you use OVPA.

) If you are running OVPA 4.x for Linux, you do not need to configure the
WLS-SPI data collector to use OVPA. By default, the WLS-SPI detects and
uses this version of OVPA to collect and store performance data. This version
of OVPA works with the integrated OVO for Windows reporting and graphing
features.

To configure the WLS-SPI data collector to use OVPA, do the following:

1 On the managed node, create a nocoda . opt file in the following

directory:
Operating System File Location
HP-UX, Linux, Solaris /var/opt/0V/conf/dsi2ddf/
AIX /var/lpp/0OV/conf/dsi2ddf/
Windows \Program Files\HP OpenView\Installed
Packages\{790C06B4 ...}\conf\dsi2ddf\

If the directory dsi2ddf does not exist, create it.

2 Edit the nocoda. opt file to contain the following single line:
ALL

3 Save the file.
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Integrating WLS-SPI with Reporter to Generate

Reports

Prerequisite: you must configure the WLS-SPI, which includes software
deployment, server connection configuration, and assignment/deployment of
policies to targeted nodes.

1

Install the WLS-SPI report package on the Windows system running
Reporter:

a Insert the HP OpenView Smart Plug-ins CD into the CD drive of the
Windows system running Reporter.

b Go tothe /WeblLogic SPI Reporter Package directory.
¢ Double-click on WLSSPI-Reporter.msi

d Complete the installation by following the instructions in the windows
that display.

Check the Reporter status pane (see the illustration that follows) to note
changes to the Reporter configuration.

For Windows 2000 managed nodes, during the installation an error message
may appear that indicates the installer has detected an older version of the
installer on your system. You can safely ignore the message and continue.

For NT 4.0 managed nodes, during the installation you may get the error:
1604: This setup does not contain the Windows Installer engine
[INSTMSIW.EXE] required to run the installation on this operating
system. In this case you must install the Microsoft Windows Installer
from the Microsoft Web site.

The status pane (at the bottom of the Reporter window) shows you
information on the programs running and any errors occurring. You can
check the status pane to see that Reporter has been updated with the
WLS-SPI reports.
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>»

WLS-

You can find instructions in the Reporter Help for assigning WLS-SPI
reports to the targeted nodes. To access Help, select Reports or
Discovered Systems in the left panel of the Reporter main window and
right-click it. Select Report Help or Discovered Systems Help from the
submenu that appears. See the topic “To assign a report definition to a
Discovered Systems Group.”

3 Add group and single system reports by assigning reports as desired. (See
the Reporter Help and the online Concepts Guide for complete
information.)

Group and single system WLS-SPI reports require that you identify
systems by their full name (for example, abe . xyz.com is acceptable
while abe is not).

SPI Reports

The reports available through the integration of HP OpenView Reporter and
WLS-SPI show consolidated data on server performance and availability on
all WebLogic Server systems. In addition, other reports show data for single
systems. These reports are available the day following your installation of the
WLS-SPI report package on the Reporter Windows system. (Please refer to
page 66 if you have not yet completed the report package installation.)

The following tables show pre-defined reports

Table 1 Performance

Report Title

WebLogic
Description Version | Metric

DB Connection Utilization | Shows DB connection pools throughput 6.x, 7.0, 260

against the connection utilization 8.1

EJB Cache Hits - Top 20 | Shows stateful and entity EJB cache hits for| 7.0, 8.1 238

the top 20 servers.

EJB Free Pool Wait Rate - | Shows the number of times per minute that| 7.0, 8.1 25

Top 20

a request had to wait for an EJB to become
available for the top 20 servers.
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Table 1 Performance
WebLogic

Report Title Description Version | Metric

EJB Pool Utilization Shows the EJB pool utilization for the top | 7.0, 8.1 235
20 servers.

EJB System Transaction | Shows the throughput (transactions per 6.1 227-230

Tput. - Top 20 second) for the top 20 EJBs for each
WebLogic Server.

EJB Timeout Rate - Top 20| Shows the number of times per minute that| 7.0, 8.1 26
a request timed out while waiting for an
EJB to become available for the top 20
servers.

EJB Transaction Rollback | EJB transaction rollback rate by EJB for | 6.1 36

Rate - Top 20 the top 20 servers.

EJB Transaction Shows the average EJB transaction 6.1 35

Throughput - Top 20 throughput for the top 20 servers.

JMS Server Util by Bytes | Charts the throughput against the queue | 6.x, 7.0, 252,
utilization by byte count for destinations on | 8.1 256
the JMS servers for each WebLogic Server.

JMS Server Util by Charts the throughput against queue 6.x, 7.0, 251,

Message utilization by message count on the JMS 8.1 255
servers for each WebLogic server.

Server Queue Throughput | Shows the average throughput for the top | 6.x, 7.0, 10

- Top 20 20 execute queues of all servers. 8.1

Server Queue Utilization | Shows the throughput against the thread |6.x, 7.0, 10,11
utilization for each WebLogic server. 8.1

Server Queue Utilization - | Shows the throughput against the thread |6.x, 7.0, 10,11

Top 20 utilization for the top 20 servers. 8.1

Servlet Avg. Response Shows the average response time for the top| 6.x, 7.0, 240

Time - Top 20 20 servlets. 8.1

Servlet Request Rates - Shows the total servlet request rate being | 6.x, 7.0, 242

Top 20 received by the top 20 servers. 8.1
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Table 1 Performance

WebLogic
Report Title Description Version | Metric
Servlet Requests - Top 20 | Shows the total servlet requests being 6.x, 7.0, 242
received by the top 20 servers. 8.1
Transaction Rollbacks Shows the average transaction rollback by |6.x, 7.0, 71
day. 8.1
Transaction Throughput - | Shows the average transaction throughput | 6.x, 7.0, 76
Top 20 for the top 20 servers by day. 8.1
Table 2  Availability
WebLogic
Report Title Description Version | Metric
Server Availability Contains a daily histogram showing the 6.x 2
percentages of uptime and downtime for all
servers.
Server Availability Details| Contains spectrum graphs showing minutes| 6.x 2

of uptime by day and hour for each
WebLogic Server.

Removing the WLS-SPI Reporter Package

1 From the Control Panel, double-click on Add/Remove Programs.

A WO DN

display.

Click on Remove.

From the Add/Remove Programs window, select WLSSPI-Reporter.

Complete the removal by following the instructions in the windows that
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Integrating WLS-SPI with HP OpenView
Performance Manager

To use Performance Manager, you must purchase and install it separately. To
integrate WLS-SPI with OVPM, do the following:

1 Install the WLS-SPI graph package on the Windows system running
Performance Manager:

a Insert the Smart Plug-ins and Integration Modules, New and
Upgraded, Volume 1 CD into the CD drive of the Windows system
running Performance Manager.

b Gotothe /WebLogic SPI OVPM Configuration Package
directory.

¢ Double-click on WLSSPI-Grapher.msi

d Complete the installation by following the instructions in the windows
that display.

2 To graph any WebLogic server metric, use the data source name:
WLSSPI_METRICS

Viewing Graphs that Show Alarm Conditions

For graphing purposes, the WLS-SPI organizes metrics according to type and
includes four groupings. When a message is generated for any metric
appearing in a table in the section that follows, you can view a chart of its and
other metric values.

To view a graph associated with an alarm condition (Operator-initiated action
has been defined with the WLS-SPI policy), complete these steps:

1 In the OVO Message Browser double-click the message.
2 In the Message Properties window select the Commands tab.
3 Press Start to start the Operator-initiated command.

The resulting action displays the metric’s WLS-SPI graph, which charts its
values along with the values of other metrics in the same group.
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Viewing Graphs that Show Past/Current Conditions

You can generate any of the available graphs manually:

1 From the OVO console, select Operations Manager - Reports & Graphs —
Graphs — SPI for WebLogic Server.

2 Double-click on the graph you want to generate.

WLS-SPI Metrics Available for Add-On Graphs

The following tables show the graphs available for mapping collected metric
values. If you are interested in viewing any one of the metrics included in any
of these tables, you can use the View Graphs tool to launch the graph, which
appears in your Web browser.

Table 3  Cluster: 80, 81

Graph Label Metric Name Metric Description

Cluster Outgoing B080_ClsOutMesFailRt Number of multicast messages per
Message Failure Rate minute resent to cluster.

Cluster Incoming B081_ClsInMesFailRt Number of multicast messages per
Message Failure Rate minute from cluster lost by the server.

Table 4 Enterprise Java Beans (EJB): 25, 26, 35, 36

Graph Label Metric Name Metric Description

Aggregate EJB Free B025_EJBFreePoolWtRt | Number of times per minute that no

Pool Wait Rate EJB beans were available from the
free pool.
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Table 4 Enterprise Java Beans (EJB): 25, 26, 35, 36
Graph Label Metric Name Metric Description
EJB Timeout Rate B026_EJBTimeoutRt Number of times per minute a client

timed out waiting for an EJB.

EJB Transaction

B035_EJBTranThruRt

Number of EJB transactions per

Throughput Rate second.
EJB Transaction B036_EJBTranRbRt Number of EJB transactions rolled
Rollback Rate back per second.

Table 5 Server Status (Serverstat): 5, 13, 14, 61, 85, 91

Graph Label

Metric Name

Metric Description

JVM Memory
Utilization Percent

B005_JVMMemUtilPct

Percentage of heap space used in the
JVM.

Socket Traffic Rate

B013_ SocketTrafficRt

Number of socket connections opened
per second.

Active Socket Count

B014_ActiveSocketCnt

Number of socket connections opened.

JDBC Connect Pool

B061_JDBCConPIWtCnt

Number of clients waiting for a

Wait Count connection from the connections pools.
Invalid Login Attempts | B085_InvLoginAttCnt Number of invalid login attempts.
Count

Timer Services
Throughput Rate

B091_TimeSerThruRt

Number of triggers executed per
second.
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Table 6

Transaction: 70, 71, 72, 73, 74, 75, 76, 77

Graph Label

Metric Name

Metric Description

Transaction Average
Time

B070_TranAveTime

Average commit time for transactions.

Transaction Rollback
Percent

B071_TranRollbackPct

Percentage of transactions rolled back,
based on the total.

Transaction Resource

B072_TranResErrRbPct

Percentage of the transactions rolled

Error Rollback Percent back due to resource error.
Transaction B073_TranAppErrRbPct | Percentage of transactions rolled back
Application Error due to application error.

Rollback Percent

Transaction Time
Error Rollback Percent

B074_TranTimErrRbPct

Percentage of transactions rolled back
due to a timeout error.

Transaction System

B075_TranSysErrRbPct

Percentage of the transactions rolled

Error Rollback Percent back, based on system error.
Transaction B076_TranThruRate Number of transactions processed per
Throughput Rate second.

Transaction Heuristic
Count

B077_TranHeurCnt

Percentage of transactions returning a
heuristic decision.
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Launching the Web Page display with an Operator Action that Generate
Graphs

Performance Manager graphs can be generated from most WLS-SPI alarm
messages by double-clicking on the message, selecting the Commands tab, and
selecting Start in the Operator Initiated section. The operator action
launches your Web browser, which can then display a graph of the metric that
generated the message as well as other related metrics.

Figure 1 A graph generated from an Operator Action

| Awtomatically Refresh Refresh Graph Now

Specifying a Date Range

Within the Web page display, you can specify a date range of one day, one
week, one month, or one year. Please see the online Help for instructions on
changing display settings.
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Removing the WLS-SPI Grapher Package

1 From the Control Panel, double-click on Add/Remove Programs.

2  From the Add/Remove Programs window, select WLSSPI-Grapher.
3 Click on Remove.
4

Complete the removal by following the instructions in the windows that
display.
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Troubleshooting WLS-SPI

This chapter covers troubleshooting the Smart Plug-in for BEA WebLogic
Server (WLS-SPI).

Error messages (listed by number) are available in the online help.
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Using the Self-Healing Info Tool

Preferred troubleshooting method: Troubleshooting information is
enhanced with cross-referencing capabilities available through the HP
support site: http://support.openview.hp.com/self_healing.jsp. To
access this information and the search capabilities available on the site, you
must first download and configure the Self-Healing Services client software,
an added benefit of your HP support contract. A link is then automatically set
up to the self-healing services web site, where your SPI problem can be
matched to similar SPI problems/solutions for increased troubleshooting
effectiveness. Refer to the Self-Healing Services section in the SPI CD
Installation Guide for information on how to download, configure, and use the
software and its automatic link to the HP web site support service.

Alternative troubleshooting method: If self-healing services is not
installed/configured on the node, you can use the Self-Healing Info tool.
This tool also gathers SPI troubleshooting data and stores it in a file that you
submit to HP support for assistance. Refer to the online help for more
information about using this tool.
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Log and Trace Files

Management Server

File Type

Filename

Description

The following log file is found on the management server (typically,
\<%0vInstallDir%>\1is \Program Files\HP
OpenView\Data\shared\):

Log

\<%OvlInstallDir%>\instal 1\WASSPI\WLSSPI\English\Discovery\log\
<managed_node>_disc_server.log

Records the updates done by the WLSSPI Discovery policy to the management
server’s configuration for each managed node. Log files are overwritten each time
the discovery policy is run on the managed node. Logging to this file is always
enabled.

UNIX Managed Nodes

File Type
Filename

Description

The following log and trace files are found on the managed nodes running on
UNIX (typically, /<OvAgentDir>/is /var/opt/OV/ or /var/lpp/OV/):

Log
/<OvAgentDir>/1og/javaagent.log

OVO discovery agent log file containing the status of the OVO discovery agent.
By default, logging to this file is enabled at L.oc_LEVEL 3. Set the L.oG_LEVEL
variable in <OvAgentDir>/conf/svcDisc/OvJavaAgent.cfg to 6 or higher
(up to 9) to capture troubleshooting information (the higher the number, the
more information is collected). To disable this log, set the L.oc_LEVEL to 0.
Additional information can be configured in this file to define log file size and the
number of archived files kept. By default, the log file size is 1MB and five
archived versions are kept.
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File Type
Directory

Description

File Type
Directory

Description

File Type
Directory

Description

File Type

Filename

Description

Log
/<OvAgentDir>/wasspi/wls/log/config.log

Records output from the WLS-SPI configuration scripts.

Log
/<OvAgentDir>/wasspi/wls/log/errorlog

Records WLS-SPI error messages. This log file is monitored by WLS-SPI policies.

Log
/<OvAgentDir>/wasspi/wls/log/wasspi_wls_discovery.log

Records output from the WLS-SPI discovery process.

Trace

/tmp/wasspi_wls_disc.trc (archived files have a three digit number
appended to the filename)

Discovery binary trace file used by your HP support representative. By default,
tracing to this file is enabled. To disable tracing, in <OvAgentDir>/bin/
instrumentation/wasspi_wls_discoveryUnix.pl, set the $trace_on
variable to 0. To enable this trace, set the $trace_on to 1. When instrumentation
is deployed, the wasspi_wls_discoveryUnix.pl file is overwritten (therefore,
if you disable tracing, it becomes enabled when instrumentation is deployed).
Five archived versions are kept. A new trace file is created when the discovery
policy is run.
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Directory
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Trace

/<OvAgentDir>/wasspi/wls/log/trace.log (archived files have a three
digit number appended to the filename)

Trace file used by your HP support representative. By default, tracing to this file
is disabled. To enable this tracing, use the start Tracing tool.

Windows Managed Nodes

File Type
Filename

Description

File Type
Directory

Description

The following log and trace files are found on the managed nodes running on
Windows (typically, <OvAgentDir>is
\Program Files\HP OpenView\Installed Packages\{790 ...}\):

Log
\<OvAgentDir>\1og\javaagent.log

OVO discovery agent log file containing the status of the OVO discovery agent.
By default, logging to this file is enabled at L.oc_LEVEL 3. Set the L.oG_LEVEL
variable in <OvInstallDir>\conf\svcDisc\OvJavaAgent.cfg to 6 or higher
(up to 9) to capture troubleshooting information (the higher the number, the more
information is collected). To disable this log, set the L.oc_LEVEL to 0. Additional
information can be configured in this file to define log file size and the number of
archived files kept. By default, the log file size is 1MB and five archived versions
are kept.

Log
\<OvAgentDir> \wasspil\wls\log\config.log

Records output from configuration scripts.
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File Type
Directory

Description

File Type
Directory

Description

File Type

Filename

Description

File Type

Directory

Description

Log
\<OvAgentDir> \wasspi\wls\log\errorlog

Records WLS-SPI error messages. This log file is monitored by WLS-SPI policies.

Log
\ <OvAgentDir> \wasspi\wls\log\wasspi_wls_discovery.log

Records output from the WLS-SPI discovery process.

Trace

C:\temp\wasspi_wls_disc.trc (archived files have a three digit number
appended to the filename)

Discovery binary trace file used by your HP support representative. By default,
tracing to this file is enabled. To disable tracing, in
\<%OvlnstallDir%>\bin\instrumentation\wasspi_wls_discoveryWin.pl,
set the $trace_on variable to 0. To enable this trace, set the $trace_on to 1. When
instrumentation is deployed, the wasspi_wls_discoveryWin.pl fileis
overwritten (therefore, if you disable tracing, it becomes enabled when
instrumentation is deployed). Five archived versions are kept. A new trace file is
created when the discovery policy is run.

Trace

\<OvAgentDir> \wasspi\wls\log\trace.log (archived files have a three
digit number appended to the filename)

Trace file used by your HP support representative. By default, tracing to this file
is disabled. To enable this tracing, use the start Tracing tool.

84



Chapter 6

The WLSSPI Discovery Policies

Problem

The WLSSPI Discovery policies do not automatically discover and update the
WLS-SPI configuration.

Solution

1 Check for errors in the message browser of the managed nodes not being
discovered. Follow the instruction text of any error messages displayed.

2 Check for errors in the <OvAgentDir>/wasspi/wls/log/
wasspi_wls_discovery.log file on the managed node.

3 Ifyou have more than one version of the WebLogic Server installed on a
managed node, set the JAVA_HOME property to the directory where the highest
version of Java is installed. If you are running WebLogic Server version 8.1,
you must use Java version 1.4.1 or higher.

4 Ifyou have both WebLogic Server version 6.1 and 8.1 installed on the same
system, set the HOME property and run the Discover WebLogic tool

5 Check if the WLSSPI Discovery policies are still being deployed:

From the OVO console, select Operations Manager - Policy management —
Deployment jobs.

e Ifthe state of a WLSSPI Discovery policy is Active, then the policy is still
being deployed. Wait for the deployment of the policy to complete.

e Ifthe state of a WLSSPI Discovery policy is Suspended or Error, then
check for any error messages in the message browser and continue to
troubleshoot the problem by reading the rest of this section.

e Ifthe WLSSPI Discovery policies are not listed, check the message
browser for the following messages

WASSPI-302: Updating WLS-SPI configuration in OVO server for
<node>

WASSPI-303: The SPI configuration for <node> was updated by
discovery in the OVO server. The updated configuration is as
shown below

If these messages are present, the WLSSPI Discovery policies have been
successfully deployed. If these messages are not present, either the
policies were not successfully deployed or the AUTO_DISCOVER check box
has not been selected in the configuration editor.

Continue to troubleshoot the problem by reading the rest of this section.
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Solution
(cont.)

10

11

12

Verify that a WebLogic application server is installed on the managed node. If
an application server is not installed, uninstall the WLSSPI Discovery policy
group from the managed node, install an application server, and complete the
configuration tasks listed in Chapter 3, Configuring WLS-SPI.

Verify the WebLogic application server status. The application server must be
running. See Task 2: Verify the Application Server Status on page 20 for more
information.

Verify that the LOGIN/PASSWORD properties are set (refer to the online help)

and that the WebLogic user configured has the correct permissions (see Task
3: Collect Application Server Information on page 21).

On a Windows managed node, if the HKEY_TLOCAI,_MACHINE\\Software\\BEA
Systems\ \BEAHOMELIST registry key does not exist, either configure it, create
the file $SystemDrive%\BEA\beahomelist, or configure the
BEA_HOME_LIST property for that managed node.

Verify the Java home directory (see Verifying the Java Home Directory on
page 90).

Verify that the discovery agent is running on the managed node:

a Run the command opcagt -status
b Look for the following:
Service Discovery Agent OvSvcDiscAgent.cmd (1084) is running

If the agent is not running, start it by running the command opcagt
-start -id 13

If you are running WebLogic Server 7.0 or higher and did not save the domain
configuration file (for example, config.xml) in the default directory
(<BEA_Home_Dir>/user_projects/<WebLogic_Domain X>/,where
<BEA_Home_Dir>is the directory that contains the registry.xml file), then
do one of the following:

e Manually set the server using the Configure WLSSPI tool, OR

e Manually configure ADMIN_PORTS, the port number(s) of the WebLogic
Admin server(s) listed in the domain configuration file, using the
Configure WLSSPI tool. The global LOGIN and PASSWORD must be
configured for the node on which these WebLogic Admin servers are
running.
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Solution
(cont.)

13 On a UNIX managed node, verify that BEA_ HOME_LIST and HOME_LIST
directory path names do not include spaces. The discover process currently
does not support spaces in directory names.

14 If you deployed the Discovery policies at the WLSSPI Discovery level or not in
the order shown in Manually Deploying the Discovery Policies on page 89,
uninstall and redeploy the Discovery policies:

a From the OVO console, select Operations Manager - Policy management —
Policy groups = SPI for WebLogic Server.

b Right-click on WLSSPI Discovery and select All Tasks = Uninstall all.
¢ Select the node(s) from which to uninstall the Discovery policies.
d Click OK.

e Redeploy the Discovery policies in the order shown in Manually
Deploying the Discovery Policies on page 89. The policies must deployed
in order. If you deployed the policies as a group, the policies may not be
deployed in the correct order.

15 Verify that the Configure WLSSPI tool is not running and/or a configuration is
not open in an editor. Only one process can access a configuration at a time. If
a configuration is open, other processes that must access that file (like the
discovery policy) hang until the file becomes available.

Problem

The WLSSPI Discovery policies are adding inaccurate information to the
configuration

Solution

1 Verify LOGIN and PASSORD are correct. Refer to Task 3: Collect Application
Server Information on page 21 for more information.

2 Verify the Java home directory. Refer to Verifying the Java Home Directory
on page 90 for more information.

3 Update the configuration and uncheck the AUTO_DISCOVER check box in the
configuration editor to prevent the WLSSPI Discovery policies from
overwriting the configuration information.
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Problem

Two or more WebLogic domains have managed WebLogic Servers on the
same OVO managed node.

Solution

From the OVO console, select Operations Manager - Policy management —
Deployment jobs.

Find the jobs in an Error state.

For each job you want to restart, right-click on it and select All Tasks - Restart
job.

Problem The following error message displays: (PMD51) Error: Unable to deploy
instrumentation files from directory <directory name>:
(NUL16389E) Unspecified error (0x80004005). Please check the
error log on the managed node.

Solution From the OVO console, select Operations Manager - Policy management —

Deployment jobs.
Find the jobs in an Error state.

For each job you want to restart, right-click on it and select All Tasks - Restart
job.

Problem

The property of critical error messages in the OVO console is: Errors
occurred during the distribution of the monitors. Solve the
problems and distribute the monitors again. (OpC30-1030).

Solution

From the OVO console, select Operations Manager - Policy management —
Deployment jobs.

Find the jobs in an Error state.

For each job you want to restart, right-click on it and select All Tasks - Restart
job.
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Manually Deploying the Discovery Policies

If the WLSSPI Discovery policies do not deploy successfully when you run the
Discover WebLogic tool, you can manually deploy them to the managed nodes
on which the WebLogic Admin Servers are running (they must be deployed in
the order shown):

1

N O O~ ODN

From the OVO console, select Operations Manager > Policy management —
Policy groups —> SPI for WebLogic Server > WLSSPI Discovery.

Right-click on WLSSPI-Messages and select All Tasks = Deploy on.

Select the node(s) on which to deploy the auto-discovery policies.

Click OK.

Right-click on WLSSPI Service Discovery and select All Tasks > Deploy on.
Select the node(s) on which to deploy the auto-discovery policies.

Click OK.

Verifying Discovery Policy Deployment is Currently Active

To check if the WLSSPI Discovery policies are still being deployed, from the
OVO console, select Operations Manager > Policy management - Deployment
jobs.

If the state of a WLSSPI Discovery policy is Active, then the policy is still
being deployed. Wait for the deployment of the policy to complete.

If the state of a WLSSPI Discovery policy is Suspended or Error, then
check for any error messages in the message browser. Refer to The
WLSSPI Discovery Policies on page 85 to diagnose the problem.

If the WLSSPI Discovery policies are not listed, check the message
browser for the following messages

WASSPI-302: Updating WLS-SPI configuration in OVO server for
<node>

WASSPI-303: The SPI configuration for <node> was updated by
discovery in the OVO server. The updated configuration is as
shown below

If these messages are present, the WLSSPI Discovery policies have been
successfully deployed. If these messages are not present, either the
policies were not successfully deployed or the AUTO_DISCOVER check box
has not been selected in the configuration editor.
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Verifying the Java Home Directory

In order to successfully use the WLSSPI Discovery policies, the Java home
directory (on both a Windows and UNIX managed node) must be configured
correctly.

Although the discovery policies search for this information, if they cannot find
this information or the information is not accurate, the discovery policies do
not function completely.

On each managed node on which you want to run the discovery policies, verify
one of the following (listed in the order of precedence used by the discovery
policies):

e JAVA HOME is correctly defined in the configuration. To edit/view the
configuration, run the Configure WLSSPI tool:

a From the OVO console, select Operations Manager - Tools - SPI for
WebLogic Server = SPI Admin.

b Double-click on Configure WLSSPI.
¢ Select the node(s) to configure.
d Click Launch.

e Javaisinstalled in each of the BEA home directories (each directory listed
in the file beahomelist).

e The JAVA_HOME system variable is correctly defined.
On a Windows managed node, do the following:
a Select Start > Settings — Control Panel.
b Double-click on System.

Select the Advanced tab.

(2]

Select Environment Variables ...

e Scroll through the System variables list. Verify the JAVA_ HOME
value. If JAVA_HOME does not exist, it is not defined.

On a UNIX managed node, do the following:

o

a Type echo $JAVA_HOME

Verify the output. If no output is returned, JAVA_HOME is not
defined.
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The Configuration

Problem

The WLS-SPI configuration does not have complete or accurate information for a
WebLogic managed server.

Solution

Verify LOGIN and PASSWORD are correct. Refer to Task 3: Collect Application
Server Information on page 21 and the online help for more information. This is
the most common reason for incorrect information for a WebLogic managed
server running on a remote node (not running on the OVO managed node).

Problem

The WLSSPI Discovery policies overwrite the configuration with inaccurate
information.

Solution

Update the configuration and uncheck the AUTO_DISCOVER check box in the
configuration editor to prevent the WLSSPI Discovery policies from overwriting
the configuration information.

Problem

The Server status is unknown (down) message appears in the message
browser but the server is running.

Solution

Check that you have correctly set the PORT, PROTOCOL, and/or PASSPHRASE
properties:

e Verify that PROTOCOL is set to one of two values: t3 (for non-SSL) or t3s (for
SSL).

e Ifthe application server is using SSL, verify that the PORT is set to a valid
SSL port number and that PROTOCOL is set to t3s.

e Ifthe application server is not using SSL, verify that the PORT is set to a valid
non-SSL port number and that PROTOCOL is set to t3.

e Ifthe keystore has a password defined, re-set the PASSPHRASE in case it has
been mistyped.
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Verifying the Node Name

Verify that the node name specified in a node or group block matches the
primary node name configured in OVO. To display the primary node name, do
the following:

1 From the OVO console, select Operations Manager > Nodes.
2 Right-click on the node and select Properties.
3 Select the Network tab.

Tools

Message

Configuration variable SERVER<n>_START_CMD missing for server "Default
Server"

Solution

Before you can successfully run the Start WebLogic tool, you must set the
START_CMD and USER properties. Set these properties using the Configure
WLSSPI tool. Refer to the online help for more information about this tool.

Message

Configuration variable SERVER<n>_STOP_CMD missing for server "Default
Server"

Solution

Before you can successfully run the Stop WLSSPI tool, you must set the
STOP_CMD and USER properties. Set these properties using the Configure WLSSPI
tool. Refer to the online help for more information about this tool.
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